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About this guide 
The WinCue Pro News prompting solution has been designed for general 

production and prompting; its features include Runorder management, 

simultaneous prompt, edit, and script timings calculation. WinCue Pro News 

can also be used to connect to networked newsroom systems; by doing this 

WinCue Pro News is able to open scripts, sent from a third party newsroom 

system, and then prompt them. This user guide has been produced to explain 

to you how to set-up and use WinCue Pro News with Active Data Receiver. 

Audience  
This guide is for all users of the WinCue Pro News Active Data Receiver 

prompting software. From complete WinCue novices to experts, this guide 

should be useful to all, providing a quick reference for experts and systematic 

help for novices. The pre-requisites to using this guide are that you are familiar 

with the Microsoft Windows environment, in particular that of Microsoft 

Word. 
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1 Set-Up 
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1.1 ADR Set-Up 
The Active Data Receiver Interface has been produced for clients that have 

developed their own newsroom system and need to connect to a WinCue 

prompter.  

WinCue can communicate with the third-party newsroom via Serial, TCP/IP, or 

SPX connection. 

As the newsroom system that WinCue will be connecting to is specific to the 

client site the Active Data Receiver (ADR) interface set-up is completely reliant 

on the settings of the newsroom system, WinCue is configured to match its 

settings. 

Before moving onto the next section of this User Guide make sure that you take 

note of the configuration settings of your newsroom system.  
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2 Configuration 
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2.1 WinCue Configuration 
In WinCue, click on the Tools menu and select Options, a WinCue 

Configuration window will open, from here click on the News Interfaces option 

and then on the Active Data Receiver option. The settings for the Active Data 

Receiver interface will appear opposite; it is here that you configure how 

WinCue and ADR communicate. 

 

2.1.1 General Settings 

This is the first window you will see upon opening the Active Data Receiver 

menu. 
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Auto Save – If this is checked, when WinCue receives an updated script, the 

script will automatically be saved to its hard drive. 

File Name – This specifies how your files will be saved if you have selected auto 

save.  

Keep Old Auto Saves – This specifies how long your old scripts will be kept for.  

Preview Mode – This is used to monitor the data that is being sent to the 

WinCue machine, when this option is selected, you will see the following 

window when “Start Receiving Downloads“ is activated. 
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2.1.2 Port Configurations  

The next tab after General Settings is the Port Configurations tab, this is where 

you set-up how your WinCue machine is going to communicate with your 

newsroom system. 

Firstly, you need to create a new port connection, to do this click on the Add 

button. 
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An ADR Port Configuration window will appear, give the new connection a 

name, and then select the port type that you will be using for the connection. 

If using a Serial connection enter the port details in the Serial port settings 

section, if using a TCP/IP or SPX connection enter the network details in the 

Network details. 

 

Once you have entered your port details click on the Profile drop-down box 

and select the Profile that you want to use, see the Profile section below to find 

out how to create a Profile. 

2.1.3 Profiles 

The next tab after Port Configuration is the Profiles tab; this is the most important 

part of the ADR system as is the used to determine how received scripts are 

treated in WinCue. 

Firstly, you need to create a new profile, to do this click on the Add button. 
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An Add Profile box will appear, enter a name for the Profile and then click on 

OK. 

 

2.1.3.1 General 

An ADR Profile Settings window will appear, it is from here that you will 

configure how WinCue will handle the incoming scripts. The first Tab will contain 

the settings for the font that is used to display the scripts, click on the Font 

button to select the font and font size of the text. 
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2.1.3.2 On-line Editing 

The tab after General is the On-line Editing tab; these options determine 

whether the WinCue user will be able to modify the scripts received by WinCue 

via the ADR interface. 

Edit Story Text – If this is selected then the user can edit the scripts. 

Re-Order Rundown – This allows the user to change the order in which the 

stories are prompted. 

Create/Delete Items – This allows the user to add or delete stories from the 

Runorder. 

Change Hold State – If this is checked then the user can put items on hold and 

they will then not be prompted. 
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2.1.3.3 Order List 

The tab after On-Line Editing is the Order list tab; the settings here are related to 

how WinCue translates the code from the newsroom system into the 

downloaded scripts you see in the WinCue Script Editor.  

Note: Before editing the available settings it is necessary that you have the 

relevant information about your newsroom system's code.  

The Order List settings are used in conjunction with the Story (Type 1) settings. 

The code information that you add in this section will be what WinCue looks for 

when it receives the ADR feed, when it sees a certain part of the code it will 

know that it is, for example, the start of a new item. The Order List settings are 

used to configure how WinCue orders the Runorders sent to it; the following 

options are available for editing: 

Start Sequence – This is used to indicate where a Runorder begins. 

Sequence Name End – This is used to indicate where an individual item ends. 
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Sequence Separator – This is used to separate the items in a Runorder. 

End Sequence – This is used to indicate where a Runorder ends. 

If the Automatically create the link option is selected then items without scripts 

will not be displayed in the Runorder. 

 

Click on the option that you wish to edit and then click on the Edit button; this 

will open an Edit Control Code box, enter the relevant details from your 

newsroom system code, and then click OK.  
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Enter the newsroom system code details for each of the options then click on 

the OK button and test them by sending a Runorder from the newsroom system 

to WinCue. 

2.1.3.4 Story (Type 1) 

As with the Order List settings, the Story (Type 1) settings are used to translate 

the newsroom system code into code that WinCue can understand. 

Note: Before editing the available settings it is necessary that you have the 

relevant information about your newsroom system's code.  

The Story (Type 1) settings, which are used in conjunction with Order List 

settings, are used to configure how WinCue handles the scripts that are sent to 

it; the following options are available for editing: 

Start Sequence – This is used to indicate where a story begins. 

Sequence queue name end – This is used to indicate the end of the name of a 

Runorder. 

Sequence ID end – This is used to indicate the end of the story ID number. 

Sequence fields start – The start of a new item field name will follow this. 

Sequence Field name tag end – This is used to indicate the end of the item 

name and the beginning of the field value. 



WinCue Pro News ADR Interface User Guide Configuration  ••••  16 

Sequence field separator – This is used to divide the end of the field data and 

the start of the next field name.  

Sequence fields end – This indicates the end of the last fields data, and by 

inference the start of the item script. 

End sequence – This indicates the end of the complete story item. 

If the Automatically create the link option is selected then items without scripts 

will not be displayed in the Runorder. 

 

Click on the option that you wish to edit and then click on the Edit button; this 

will open an Edit Control Code box, enter the relevant details from your 

newsroom system code, and then click OK.  
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Enter the newsroom system code details for each of the options then click on 

the OK button and test them by sending a Runorder from the newsroom system 

to WinCue. 

2.1.3.5 Story (Type 2) 

Like Story (Type 1), Story (Type 2) is used to translate the third party newsroom 

system code into WinCue script items. Unlike the Story (Type 1) settings, with 

Story (Type 2) settings you are able to choose which Control Code you wish to 

use in code transfer. 

The Control Codes that you can add and remove are as follows: 

Generic Data String 1 – 10: These 10 fields are used to display text. 

Item Number: This will add the item numbers to the Runorder. 

Presenter Name: This will add presenter names to the Runorder. 

Queue Title: This will add the name of the queue to the Runorder. 

Unique ID: This will add the Runorders ID. 

The Story (Type 2) settings are used in conjunction with the Runorder (Type 2) 

settings. 
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To add one of these fields to the translation process simply click on the Add 

button and select it from the list of fields. 
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Then add the relevant code from your newsroom system into the Field 

Information box, click on OK, and then test them by sending a Runorder from 

the newsroom system to WinCue. 

 

2.1.3.6 Rundown (Type 2) 

Like Story (Type 1), Story (Type 2) is used to translate the third party newsroom 

system code into WinCue rundowns. Unlike the Story (Type 1) settings, with Story 

(Type 2) settings you are able to choose which Control Code you wish to use in 

code transfer. 

The Control Codes that you can add and remove are as follows: 
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Generic Data String 1 – 10: These 10 fields are used to display text. 

Item Number: This will add the item numbers to the Runorder. 

Presenter Name: This will add presenter names to the Runorder. 

Queue Title: This will add the name of the queue to the Runorder. 

Unique ID: This will add the Runorders ID. 

The Runorder (Type 2) settings are used in conjunction with Story (Type 2) 

settings.  

 

To add one of these fields to the translation process simply click on the Add 

button and select it from the list of fields. 

Then add the relevant code from your newsroom system into the Field 

Information box, click on OK, and test them by sending a Runorder from the 

newsroom system to WinCue. 
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2.1.3.7 Return On-Prompt Item (Unique ID) 

The Return On-Prompt Item settings are used to enable WinCue to send 

information back to the newsroom system from the prompter.  

Note: It is necessary that your newsroom system is able to receive files that are 

sent from the WinCue prompter. 

Firstly enable the setting by clicking on the Return On-Prompt Item check box, 

once you have done this the Edit Start Sequence button, and Edit End 

Sequence button will become enabled. Click on the Edit Start Sequence 

button to enter the code that will signal the start of the information being sent 

back to your newsroom system. Then click on the Edit End Sequence button to 

enter the code that will signal the end of the information being sent to your 

newsroom system. Once you have added the coding details to both of these, 

WinCue will be able to send information back to your newsroom system. 
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2.1.3.8 Goto Prompt 

This option will force WinCue to go to a specific item, in your Runorder, when a 

specified sequence is received. Enter where the sequence should start by 

clicking on the Edit Start Sequence button, type in the code and then select 

OK. Enter where the sequence should end by click on the Edit End Sequence 

button, type in the code and then select OK. 

 

 

2.1.3.9 Formatted Text Conversion 

The Formatted Text Conversion settings are used to translate and convert a 

received control code into a WinCue element. WinCue elements include 

Markers, Colours, Not Captioned, Not Prompted and many more; to find out 

more about these WinCue elements see your WinCue Pro News User Guide. 

To add a new element to the code translation settings click on the Add button. 
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This will open a Text Conversion Settings window, click on the Insert Control 

Code in Target String button and a list of WinCue elements will appear. Select 

the element you want to add and it will appear in the Convert To: box.   
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Insert your newsroom systems equivalent code, for the WinCue element, in the 

Convert to: box. Then insert the equivalent code from your newsroom system 

into the Convert from: box. 

The following Options explained: 

Start Ignore: If this setting is checked then the control code used will be a signal 

for WinCue to ignore the subsequent transferred code.  

Stop Ignore: If this setting is checked then the control code used will be a signal 

for WinCue to stop ignoring and to start using the subsequent transferred code. 

Case Sensitive: If this setting is checked then the control code must be 

received in the case specified in the Text Conversion settings in order for it to 

be converted into a WinCue element.  
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Once you have entered the required information to the Text Conversion 

Settings click on OK and the control code will be ready to convert the 

newsroom system code into a WinCue element. 

 

2.1.3.10 Code Page 

Use the Code Page tab to select the code page that the newsroom system 

that you will connect with the ADR interface uses. 

 

2.1.3.11 Presenter Settings 

The Presenter Settings and Presenter tabs are used to create and configure 

Presenters that can be used in the prompted scripts, to find out about to 

configure these see your WinCue Pro News User Guide. 



WinCue Pro News ADR Interface User Guide Configuration  ••••  26 
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2.1.3.12 Banner 

The Banner tab is used if you want to change the colour or font style used for 

the prompter banner. See your WinCue Pro News User Guide for more 

information about setting this up. 

 

2.1.4 Logging 

Click on the Logging Tab, it is from here that you are able to configure the 

settings for how WinCue will report any problems that it has while using the ADR 

interface. 

There are two options that can be enabled these are File Logging, reports are 

sent to a log file in the WinCue folder, and Display Logging, reports are 

displayed in a box on your screen. 
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2.2 Quick Configuration 

The following instructions have been provided to assist those who need to set-

up their ADR connection quickly 

1. Click on the Tools menu; select Options, then News Interfaces, and then 

Active Data Receiver. 

2. From the ADR options first menu (General) select Preview Mode. 

3. Then select the Profiles tab and select Add, give the Profile a name, e.g. 

test, do not change any other settings at this time. Click on ok  

4. Click on the Port Configurations tab and select Add 

5. Type in a name, e.g. COM1, and then fill in the Com port settings that your 

news interface will use to transmit its serial data.   

6. Go to the profile pull down menu (bottom right) and select the profile 

created in step 3, click OK. 

7. Come out of the Options window, click on the File menu, and select Start-

Receiving Download. You should now see all the sent text in the ADR 

window, if nothing appears re-check your settings or try restarting WinCue. 
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8. If you get the error (ADR port configuration unknown) ignore this and click 

OK. You may have to re-enter your settings. 

9. When the transfer has finished click on the Save to File button. 

10. This will make a text file; called adrlog.txt, in the wincue\logs folder and it 

will contain the profile information used. From this file, you can work out the 

settings needed to complete the profile for WinCue.   

11. So now, you can make a new profile and change the settings in the ADR 

Profile settings menu. 

If you have any problems setting up the profile you can send us the adrlog file, 

we can then look through it and find a solution.     
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3 Opening ADR Scripts in 
WinCue 
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3.1 Opening ADR scripts 
Once you have connected the WinCue machine to the ADR network, as 

discussed in the previous sections, you will be able to open Runorders and 

scripts from the ADR newsroom system. This section will explain how to open 

these ADR scripts in WinCue. 

In WinCue click on the red folder button on the toolbar:  

Or 

Left-click on the File menu and then select Open Queue from the drop-down 

menu. 

 

WinCue will now attempt to connect to the ADR server. 

The 'Runorder/Queue Browser' will then be displayed. You can then edit and 

prompt the scripts within the Runorder as described in the WinCue Pro News 

manual provided with your WinCue Pro News package. 

3.1.1 The Queue Browser 

All the available Runorders that have been dumped from the ADR terminal are 

listed in his box. 
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If the Runorder that you wish to load (for prompting) is not listed in this box 

ensure that the Runorder has been dumped from the ADR machine. 

To open an ADR Runorder on WinCuePro ready for prompting, do either of the 

following: 

Double left-click on the Runorder that you want to open. 

Or 

Left-click (select) the Runorder you want to open and then click on the 'OK' 

button. 

A Scanning ADR Folder dialog box will appear showing you WinCue's progress 

in connecting to the ADR Queues selected. 

The Runorder will then be opened and be set ready to start prompting. 

3.2 Panic Mode 
WinCuePro has a Panic Mode option that allows ADR Runorders and stories to 

be manipulated from WinCuePro if the ADR system stops working for any 

reason such as a network failure. 

IMPORTANT: The 'Panic Mode' feature should only be used as a last resort. 
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If Panic Mode is enabled the WinCue machine will stop trying to receive 

updates from ADR, as soon as Panic Mode is disabled the WinCue machine will 

re-start trying to receive updates from ADR. 

Note: Any changes to the Runorder and stories on WinCuePro while in 'Panic 

Mode' will be lost as soon as 'Panic Mode' is disabled 

3.2.1 Enabling/Disabling Panic Mode 

Click on the Panic Mode icon on the tool bar at the top of the screen to toggle 

Panic Mode. When the button is shown as pressed in Panic Mode is enabled, 

otherwise it is disabled: 

Panic Mode disabled:  

Panic Mode enabled:  

While in Panic Mode: 

The Runorder can be changed on WinCue in the same way that it is changed 

on ADR (i.e. dragging and dropping stories with the mouse). 

To Delete/drop a story, left-click (select) the story and then press the Delete 

key, the story will then be moved to the Trash Can at the bottom of the screen 

(stories can be dragged back out of the Trash Can). 

To Insert a New story, right-click below the placement for the new story. 

A drop-down menu will then appear, select New, then Single-column Script. 

You will be asked for the name/title of the new story, type it in and select the 

OK button. 

Double-click on a story to view it and edit it. The editor works in the similar way 

as the NEXUS editor, but stories do not have to be saved. 
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4 Technical Support 
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4.1 Technical Support 
Technical Support is of prime importance to the management of Autocue, we 

therefore provide a 24-hour help line service to assist and advise. 

For more technical help or advice, please call our 24-Hour Technical Support 

Help Line: 

For customers located in Europe, Asia, Africa, and Australia call: 

+44 208 665 2992 

For customers located in the Americas, call: 

 +1 704.377.1496 
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